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Publication History

The contents list on the next page identifies the publication date of each section 
of your copy of this manual. See “How to Verify That Your Manual Is Current” 
below for instructions on how to make sure that you have the current version 
of the manual.

How to Verify That Your Manual Is Current

Take the following steps to ensure that all sections of your manual are current:

■ To make sure you have the current version of this manual for your release 
level, compare the date shown on the title page to the publication date for the 
Adobe Acrobat version of this manual on the Datatel Web site 
(www.datatel.com/documentation).

■ To make sure that your copy of the manual has been updated with all 
previous revisions, check that the date at the bottom of each page matches 
the corresponding date for that section in the contents list on the next page.

If you determine that one or more sections is outdated, we recommend that you 
download the entire manual from the Datatel Web site 
(www.datatel.com/documentation).

Tracking the History of Revisions

The contents list shows only the date of the latest revision of each section; it 
does not show a history of previous revisions or the reasons for revisions. Each 
update to this manual includes a memo describing the reasons for the update. 
If you want to track the history of revisions and the reasons for revisions, keep 
the update memos with your copy of this manual.
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1
1

Logging In May 24, 2006

In This Chapter

This chapter helps you learn how to access User Interface (UI) Desktop and 
UI Web with Benefactor or Colleague. It includes instructions for logging into 
UI Desktop and UI Web.

Procedure for Logging Into UI Desktop

Complete the following steps to log into UI Desktop.

Step 1. To display the Login dialog box, do one of the following:

■ Double-click the desktop icon .

■ From the Windows Start menu, select Programs|Datatel|Datatel.

The Login dialog box is displayed, as shown in Figure 1-1.

Figure 1-1: User Interface Desktop Login Dialog Box

Step 2. Enter your user ID, password, and database.

Step 3. Click OK. 

 

Pull down 
to display 
accounts 
available
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UI Desktop and UI Web: Logging In
A message box appears, informing you that UI is loading the application files. 
When the files are loaded, the UI Desktop window is displayed, as shown in 
Figure 1-4 on page 1-7.

Technical Tip: 

After logging into a UI session (UI Desktop only), you may wish to 
bring up a second session for the same database account. You can do 
so quickly, and without having to log in again by selecting the New 
Session|Current Account option from the File menu of any form. 
You can also select the New Session|New Account option to log into 
a different account.
1-2 Guide to User Interfaces, May 24, 2006
© 2006 Datatel, Inc.



In This Chapter

 

Procedure for Logging Into UI Web

Complete the following steps to log into UI Web:

Step 1. Access the Login dialog box.

The Login dialog box is displayed, as shown in Figure 1-2.

Figure 1-2: UI Web Login Dialog Box

Step 2. Enter your user name, password, and the database you want to access.

Step 3. Click Login. 

You are prompted with a security dialog, which asks if you want to trust 
IBM’s signed applet (see Figure 1-3).

 

Pull down 
to display 
accounts 
available

Note:  The Database field is dependent on the User ID you enter. The 
Database field is not enabled until you enter a User ID.
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UI Desktop and UI Web: Logging In
Figure 1-3: UI Web Security Warning Dialog

You can select one of the following: 

■ Always. Datatel recommends selecting this option, so you will not see the 
security dialog again.

■ No. Datatel recommends not selecting this option, as this is sometimes 
difficult to reverse, and it may prevent you from being able to run the applet 
from your browser.

■ Yes. Selecting Yes causes the security warning dialog to be issued each 
time you open the link, (until you select Always or No).

The UI Web window is displayed, as shown in Figure 1-9 on page 1-12.
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UI Desktop and UI Web
1
1

Navigation May 24, 2006

In This Chapter

This chapter helps you learn how to use UI with Benefactor or Colleague. It 
includes instructions for accomplishing various tasks, such as accessing a 
form, saving your work, and using online help.

UI Desktop and UI Web provide you with almost identical functionality. 
However, the look, feel, and location of many menus and buttons are slightly 
different. See the sections, “The UI Desktop Window” on page 1-6 and “The 
UI Web Window” on page 1-11 for detailed information about the differences 
between UI Desktop and UI Web. The remaining sections of this manual refer 
to UI Desktop and UI Web collectively.

Features of UI include:

■ Tabbed multiple forms managed within the window.

■ A Detail button next to every field that allows detail.

■ A Windows Explorer-style tree structure for process menus.

■ A “Favorites” feature enabling quick access to commonly used processes.

■ An address bar for launching specific processes.

■ A drop-down box next to every field that has validation codes.

■ A calendar button next to every date field.

■ A calculator button next to every numeric field.
Guide to User Interfaces, May 24, 2006 1-5
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UI Desktop and UI Web: Navigation
The UI Desktop Window

The UI Desktop window, shown in Figure 1-4 on page 1-7, contains all the 
processes you use while working with Benefactor or Colleague as shown 
through the UI Desktop interface. The following sections describe the 
functional areas of the window. The window includes several components, 
such as the title bar, menu bar, address bar, toolbar, and any Datatel forms that 
are currently open.

Step 1. If necessary, select the application with which you want to work from the 
Apps menu at the top of the window. The left pane of the window displays the 
folders and processes available for the selected application in an expandable 
tree format.

Step 2. Click the Plus sign  next to any folder icon in the left pane to expand the 
folder. When a folder is expanded, you can click the Minus sign  next to its 
icon to collapse it.

Step 3. Double-click a folder icon to expand the folder. Double-click a form icon to 
open the form.

When a form is open, it is displayed in the right pane. When no form is open, 
the right pane displays the contents of the folder that is currently selected.

Note:  UI Web provides you with the same functionality as UI Desktop. 
However, the look, feel and location of many menus and buttons are 
slightly different. Refer to “The UI Web Window” on page 1-11 for 
information about the User Interface Web window.
1-6 Guide to User Interfaces, May 24, 2006
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The UI Desktop Window

Applicati
Icon

Menu Bar

 

Procedure for Navigating the UI Desktop Window

Figure 1-4: User Interface Desktop Window

Contents of the folder 
currently selected in the left 
pane.

Treemenu pane

Current 
Application

Current 
Account

on 
Title Bar

Window Control 
Buttons

Toolbar
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UI Desktop and UI Web: Navigation
Parts of the UI Desktop Window

Title Bar

The title bar, shown in Figure 1-5, tells you which Colleague or Benefactor 
database you are accessing and which application you are currently running. 
The title bar is highlighted when the window is the active window.

Figure 1-5: UI Desktop Title Bar

Application Icon

Click the application icon  to access the application icon options: Restore, 
Move, Size, Minimize, Maximize, or Close. Depending on the current state of 
the window, some options may not be available. To close the window when no 
forms are open, you can double-click the system menu box. If any forms are 
open, a message indicates that you cannot close the control box when you are 
in a form.

Menu Bar

The menu bar, shown in Figure 1-6, enables you to do the following:

■ Perform routine tasks, such as save your work or cut and paste items.

■ Choose an application with which to work; for example, the Financial 
System or the Human Resources System.

■ Choose a form in which to work.

■ Define your preferences for how forms are displayed.

■ Access online help.

Figure 1-6: UI Desktop Menu Bar

Database Application

Application Menu
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The UI Desktop Window
Toolbar

The toolbar, shown in Figure 1-7, provides easy access to common functions, 
such as saving your work, canceling changes, deleting records, and accessing 
online help.

Figure 1-7: UI Desktop Toolbar

Quick Access

The Quick Access field enables you to access any form directly by entering its 
mnemonic, or by using the drop-down menu button  to select a recently 
used mnemonic. Press ENTER or click Go  to display the selected 
form.

Record Delete

The Record Delete button is used to delete an entire record, and works only 
for forms that have been defined to allow this option. When you click this 
button, you are prompted to confirm that you want to delete the entire record.

Save and Cancel

The Save All and Cancel All buttons and the corresponding File drop-
down menu options, enable you to save or cancel all of your changes 
simultaneously to every form that is currently open in this session. The Save 
and Cancel buttons enable you to save or cancel changes to the current 
form.

 
 

 

Save Cancel

Save All

Cancel All

Delete 
Record

Field 
Help

Hide/Show 
Menu Tree
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UI Desktop and UI Web: Navigation
Hide/Show Menu Tree

While a form is open, you can allocate more viewing space to it by clicking 
the Hide/Show Treemenu button. The left treemenu pane closes, and the 
form occupies the entire window. Click the Hide/Show Treemenu button 
again to toggle this option off and display the treemenu in the left pane.

Window Control Buttons

The Window Control buttons, shown in Figure 1-8, enable you to minimize, 
maximize, or close the window.

Figure 1-8: UI Desktop Window Control Buttons

When the window is maximized, the Maximize button is replaced by the 
Restore button in the Window Control.

Minimize

Maximize

Close

Note:  You can also resize the window by dragging its outer frame.
1-10 Guide to User Interfaces, May 24, 2006
© 2006 Datatel, Inc.



The UI Web Window
The UI Web Window

The UI Web window, shown in Figure 1-9 on page 1-12, contains all the 
processes you use while working with Benefactor or Colleague, as shown 
through the UI Web interface. The following sections describe the functional 
areas of the window. The window includes several components, such as the 
title bar, menu bar, address bar, toolbar, and any Datatel forms that are 
currently open.

Procedure for Navigating the UI Web Window

Step 1. If necessary, select the application which you want to work from the Apps 
menu at the top of the window. The window displays the folders and 
processes available for the selected application in an expandable tree format.

Step 2. Click the Expand tree node  next to any folder icon to expand the folder. 

When a folder is expanded, you can click the Collapse tree node  next to 
its icon to collapse it.

Step 3. Double-click a form icon to open the form.

Note:  UI Web displays the window in a single pane, as opposed to the 
UI Desktop double pane.
Guide to User Interfaces, May 24, 2006 1-11
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UI Desktop and UI Web: Navigation

Menu 
Bar

Tool 
Bar
Figure 1-9: UI Web Window

Tree Menu
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The UI Web Window
Parts of the UI Web Window

Menu Bar

The menu bar, shown in Figure 1-10, enables you to do the following:

■ Perform routine tasks, such as save your work or cut and paste items.

■ Choose an application with which to work; for example, the Financial 
System or the Human Resources System.

■ Choose a form in which to work.

■ Create a list of favorite forms.

■ Define your preferences for how forms are displayed.

■ Access online help.

Figure 1-10: UI Web Menu Bar

Toolbar

The toolbar, shown in Figure 1-11, provides easy access to common 
functions, such as saving your work, canceling changes, deleting records, and 
accessing online help.

Figure 1-11: UI Web Toolbar

Quick Access

The Quick Access field enables you to access any form directly by entering its 
mnemonic, or by using the drop-down menu button to select a previously used 
mnemonic. Press ENTER or click Go to display the selected form.
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UI Desktop and UI Web: Navigation
Save and Cancel

The Save and Cancel buttons enable you to save or cancel changes to the 
current form. The Save All and Cancel All buttons and the 
corresponding File drop-down menu options, enable you to save or cancel all 
of your changes simultaneously to every form that is currently open in this 
session. 

Record Delete

The Delete button is used to delete an entire record, and works only for 
forms that have been defined to allow this option. When you click this button, 
you are prompted to confirm that you want to delete the entire record.

Menu

While a form is open, you can allocate more viewing space to it by clicking 
Menu. The left treemenu pane closes, and the form occupies the entire 
window. Click Menu again to toggle this option off and display the treemenu 
in the left pane.

Help

Click Help to view online help.

Exit

Exit UI.
1-14 Guide to User Interfaces, May 24, 2006
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Envision Forms in UI
Envision Forms in UI

Most of your work in Colleague and Benefactor is done through Envision 
forms. In documentation for earlier interfaces, what we refer to here as a 
“form” is often called a “screen.” They are the same thing; we have chosen to 
use the term “form,” however, to keep our terminology consistent with 
standard Windows usage.

When you select a form, it appears in the right pane of the window, as shown 
in Figure 1-12, with its name and mnemonic displayed on a tab. You can 
choose to have the left pane of the window remain visible (default condition), 
or to hide it in order to allocate more space to the form.

Figure 1-12: Sample Form in UI Desktop Window

Show TreeMenu Option Enabled Form Tab

Envision Form

Form 
Icons
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UI Desktop and UI Web: Navigation
Types of Forms

Menus and submenus are represented by form icons, while forms are 
represented by four different icons according to functionality. The folder 
icons are described in Table 1-1.

Icon Name Description of Datatel Form Icons

Maintenance Allows you to enter and change data that is permanently recorded in your 
database; for example, a person’s name and address.

NOTE: If your system administrator has given you read-only access to a 
maintenance form, you will be able to access it in inquiry mode only, even 
though it displays the Maintenance icon in the treemenu.

Processing Allows you to start a program that manipulates a record or group of records 
behind the scenes; for example, posting a group of transactions to the general 
ledger.

Inquiry Allows you to view information without changing it; for example, the history of a 
general ledger account. Strictly speaking, inquiry forms are forms that are 
designed to display information without allowing changes to that information. In 
contrast to an inquiry form designed as such, you may also access a 
maintenance form in inquiry mode if your system administrator has given you 
read-only access to it. Although the effect for you is the same, a maintenance 
form viewed in inquiry mode is, nevertheless, different from a form designed 
specifically as an inquiry form.

Reporting Allows you to generate a particular report according to your specifications. For 
example, today you may wish to see a report on vouchers with a due date two 
weeks from now, and tomorrow you may decide you want to see the same 
report for vouchers with a due date four weeks from now.

See “Browsing Reports” beginning on page 1-52 for information about the 
Report Browser.

Table 1-1:  Description of Datatel Form Icons
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Accessing Forms

You can access a form in several ways:

■ TreeMenu

■ Quick Access

■ List of Favorites

■ Envision Run Dialog Box

Accessing Forms From the TreeMenu

The graphical, tree-structured menus enable you to navigate through an 
application’s menus and submenus by pointing and clicking, while 
maintaining a comprehensive view of the entire menu. When you select an 
application, the window menu form is displayed. The left treemenu is the 
main navigational menu.

Use the treemenu to navigate through the folders. When you have selected the 
appropriate top-level folder, you can expand it to locate the desired form. To 
select a folder or form in a treemenu, double-click it.

Figure 1-13: Icons on the Treemenu

Accessing Forms From the Quick Access Field

Enter a form mnemonic in the Quick Access field, or use the drop-down list to 
select a previously used form mnemonic. 

Press ENTER or click Go to display the form. 

Figure 1-14: Quick Access Field

Double-click 
form icon
Guide to User Interfaces, May 24, 2006 1-17
© 2006 Datatel, Inc.



UI Desktop and UI Web: Navigation
Accessing Forms From the List of Favorites

Use the Favorites menu to select a form that has been previously added to 
your list of favorites, as shown in Figure 1-15. See “Defining Favorites” 
beginning on page 1-71 for information about creating a list of favorites.

Click the File menu to display the mnemonics of the last ten forms you 
accessed, and select a form from the list.

Figure 1-15: List of Favorites

Accessing Forms From the Envision Run Dialog Box

Choose Run from the File menu. The Envision Run Dialog box appears, as 
shown in Figure 1-16. Enter the mnemonic of the form you want, and click 
OK.

Figure 1-16: Envision Run Dialog Box

The details of the sample form are shown in Figure 1-17.

Note:  Depending on your font, resolution, and monitor size, scroll 
bars are available as needed to view forms that do not fit in the 
window.
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Figure 1-17: Sample Form Detail

Form NameForm 
Mnemonic

Header 
Block

Data 
Area

Note:  While a form is open, you can allocate more viewing space to it 
by clicking Hide/Show Treemenu. The left treemenu pane closes, 
and the form occupies the entire window. Click Hide/Show 
Treemenu again to toggle this option off and display the treemenu in 
the left pane.
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Parts of a Form

Form Tab

The form tab displays the form mnemonic and the form name. When more 
than one form is open, the tab farthest to the right represents the active form.

Form Mnemonic and Name

A mnemonic provides you with a quick way to access a form. 

Header Block

The header block displays data that identifies the record with which you are 
working. For example, the header block in Figure 1-17 on page 1-19 displays 
a student’s name and ID.

Data Area

The contents of the data area differ depending on the form on which you are 
working. In general, the data area consists of various types of fields.

Fields

A field is any place on the form where data is displayed or where you enter 
data. In most cases, each field is accompanied by a field label indicating what 
kind of data belongs in the field.

What you are allowed to enter in a field may be restricted by Benefactor or 
Colleague. For example, you can enter any combination of letters for a 
person’s name. On the other hand, in the Type field on the Core System’s 
Address Maintenance (ADR) form, you can only enter one of the values from 
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the list of valid address types, such as “Home,” “Business,” or “Local.” Fields 
such as this, where your entries are restricted, are referred to as “validated 
fields.”

Table

A table is a set of related fields. Each field in a table can have multiple values. 
Furthermore, there are usually several fields in a table that are associated with 
each other in some way; these are often referred to as associated multivalues. 
Some sets of associated multivalues are presented as rows and some are 
presented as columns; that is, some tables are row-oriented and some are 
column-oriented. In either case, the intersection of a column and a row is 
referred to as an element.

The Line Items group shown on the Relation Information (REL) form in 
Figure 1-18 is a row-oriented group. You read each set of fields across a row.

Note:  With fields that are code-driven, such as validated fields, you 
will notice that the code’s description disappears when you are 
entering data in the field. This is intentional. The code’s description 
returns as soon as you leave the field. See “Drop-Down List Button” 
beginning on page 1-27 for information about selecting codes for 
validated fields.
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Figure 1-18: Example of a Row-Oriented Group 

Table

Element

Row
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Form Control Buttons

UI offers several control buttons that assist you in viewing and editing data, as 
shown in Figure 1-19.

Figure 1-19: Form Control Buttons

Detail Button

Some forms give you only limited or summary information about a certain 
item, but provide you with the capability of moving to another form. This 
form, which is known as a detail form, provides more complete information 
on that item. 

For example, as shown in Figure 1-20, the Student Profile (SPRO) form 
contains the Academic Program field. The Academic Program field provides 
only a code that indicates the name of the program. To the right of the field is 
a Detail button , which allows you to detail to the Student Academic 
Program (SACP) form for more information about the academic program.

Window 
Operation 
Button

Detail Button

Date/
Calendar 
Button

Calculator 
Button

Drop-Down 
Table Button

Scroll Buttons
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Figure 1-20: SPRO Form Detailed to SACP Form

Although the usual workflow is to access a detail form from another form, 
some detail forms are also available from the treemenu. Others, even though 
they are not listed on a menu, may still be accessed directly. Detail forms that 
can be accessed only via another form are referred to as detail-only forms. If 
you try to access a detail-only form directly, a message is displayed telling 
you that you cannot do so.
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You will know a detail form is available from a field if there is a Detail button 
to the right of the field. Such fields are referred to as detail fields.

Window Operation Button

A Window Operation button  enables you to insert or delete a row of 
data. When you click the Window Operation button, the Select Window 
Operation dialog box is displayed, as shown in Figure 1-21.

Figure 1-21: Select Window Operation Dialog Box

■ Click Insert to insert a new row above the current row.

■ Click Delete to delete the current row.

■ Click Cancel to leave the row unchanged and return to editing.

Scroll Button

Scroll buttons enable you to view multiple values. There are two different 
types of scroll buttons: 

 Small buttons appear to the right of fields that display one value at a 
time. 

 Larger buttons appear to the right of fields that display two or more 
values at a time.

Note:  The tab farthest to the right represents the active form. To 
ensure that each record is completed properly, only one form can be 
edited at a time. All forms below the current open form are inquiry only 
and do not allow input. Data on these forms is grayed out while another 
form is active.
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Date/Calendar Button

A Date/Calendar button  appears to the right of each date field. Click the 
Date/Calendar button to display the calendar browser, as shown in 
Figure 1-22.

Figure 1-22: Calendar Browser

Click the single arrows to scroll the calendar backwards  or forwards  
by month, or the double arrows to scroll backwards  or forwards  by 
year. Click the desired date in the body of the calendar to select it.

Calculator Button

A Calculator button  appears to the right of each numeric field. Click the 
Calculator button to display a calculator, as shown in Figure 1-23.

Figure 1-23: Calculator Feature
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Drop-Down List Button

A Drop-Down Table button  appears to the right of each field that has a 
predetermined set of valid entries. Click the Drop-Down List button to display 
a list of valid codes, as shown in Figure 1-24.

Figure 1-24: Validation Code Table

Click the appropriate code to select it.
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Finding a Record

Most maintenance forms require you to select a specific record to view or 
maintain. For example, to change a person’s address, you must first specify 
which person you want to see.

You specify the record to work with by responding to the LookUp prompt that 
is displayed after you access a form. LookUp prompts are labeled according 
to the type of LookUp you are performing.

LookUps that pertain to people or organizations are referred to as person- and 
organization-related LookUps. Person LookUp, Student LookUp, Applicant 
LookUp, and Vendor LookUp are a few of the person- and organization-
related LookUps in Benefactor or Colleague.

Some fields within forms are validated against other files. LookUp is used in 
such fields to help you locate valid codes or items that you want to associate 
with the main record on which you are working. When you are in a field that 
is validated against another file, you will see a LookUp indicator in the lower 
left corner of the form, as shown in Figure 1-25.

Figure 1-25: Example LookUp Indicator for a Field

Field Validated 
Against Another File

LookUp Indicator
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Using LookUp to Find Records

If you know the ID, or key, for the record you need, you can simply enter it at 
the LookUp prompt. For example, Beth Hancock’s ID number is 0356. As 
shown in Figure 1-26, if you enter 0356 at the Person LookUp prompt for the 
Name and Address Maintenance (NAE) form, information about Ms. 
Hancock is displayed.

Figure 1-26: Basic LookUp

When you do not know the record ID, LookUp provides a number of options 
that help you find the record using the information you do have. For example, 
if you do not know Ms. Hancock’s ID number, you can enter her last name at 
the Person LookUp prompt. If you enter “hancock” at the Person LookUp 
prompt for the Name and Address Maintenance form, a resolution form 
displays a list of all the people in your database whose names begin with 
“Hancock.”1 You can then select Beth Hancock from this list. See “Finding 
Multiple Records” beginning on page 1-30 for more information about 
finding multiple records.

1. A resolution form is a form that displays a list of all records that match the search 
criteria you entered at the LookUp prompt.
Guide to User Interfaces, May 24, 2006 1-29
© 2006 Datatel, Inc.



UI Desktop and UI Web: Navigation
Finding Multiple Records

When you want to review or work with a set of records on a given form, you 
can select multiple records directly from a resolution form, as shown in 
Figure 1-27.

Figure 1-27: Resolution Form

You can select a group of records in any of the following ways:

■ Click the box to the left of the Seq: Name heading, or enter FA (Flag All) in 
the Controller LookUp Resolution box to select all records in the list.

■ Click the box to the left of each desired record.

■ Use the keyboard to enter F(lag) in the Controller LookUp Resolution box, 
followed by each sequence number of the record you want to select. Each 
selected record is highlighted when you press ENTER.

Select All Records

Select 
Desired 
Records

Controller LookUp 
Resolution Box
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When you have selected all the records you want, click the Save button at the 
bottom of the resolution form. UI displays the first of your selected records on 
the form. 

You can make changes, save, and exit. You can then display the next record or 
jump to another record in the group. UI Desktop shows which record is 
currently displayed at the bottom of the form, as shown in Figure 1-28.

Figure 1-28: Displaying One Record of a Group
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Toggling Through Multiple Records

To toggle through the records in a group, you must first save or cancel 
changes to the currently displayed record.

Save a Record and Display Another Record

Perform the following steps to save the current record and display another 
record in the selected group:

Step 1. Click Save. An alert box prompts you to update, cancel or return to editing, 
as shown in Figure 1-29.

Figure 1-29: Alert Dialog Box: Update, Cancel, or Return

Step 2. Click Update. An Alert box is displayed, as shown in Figure 1-30.

Figure 1-30: Alert Dialog Box: Discard, Previous, Next, or Jump

Step 3. Choose one of the following actions:

■ Click Previous to move to the previous record in the list.

■ Click Next to move to the next record in the list.

■ Click Jump to select a specific record in the list.

■ Click Discard to discard the entire list.
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Cancel Your Changes and Display Another Record

Perform the following steps to cancel your changes to the current record and 
display another record in the selected group:

Step 1. Click Cancel. An alert box prompts you to cancel or return to editing, as 
shown in Figure 1-31.

Figure 1-31: Alert Dialog Box: Cancel or Return

Step 2. Click Cancel. An alert box is displayed (an example of the alert box is 
shown in figure 1-30).

Step 3. Choose one of the following actions:

■ Click Previous to move to the previous record in the list.

■ Click Next to move to the next record in the list.

■ Click Jump to select a specific record in the list.

■ Click Discard to discard the entire list.
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LookUp Shortcuts

There are a number of standard LookUp options available to help you with 
almost all types of LookUp. 

In addition to these standard options, many types of LookUp also provide 
special shortcuts to help you find what you are looking for. See “Person- and 
Organization-Related LookUp Shortcuts” beginning on page 1-38 for more 
information about special LookUps.

Standard LookUp Shortcuts

There are several LookUp shortcuts that work with most types of LookUp. 
LookUp options that do not work for person- and organization-related 
LookUps are noted in the “Hints” column in Table 1-2.

When you want to see...
Enter this at the LookUp 

prompt
Hints

The last record you displayed 
during this login session.

An “at” sign (@)

For example, both the Name and 
Address Maintenance (NAE) form 
and the Address Maintenance 
(ADR) form are people-related 
forms. If you display Fred Smith’s 
record on the NAE form, and then 
you access the ADR form, you can 
retrieve Mr. Smith’s record on the 
ADR form by entering @.

The “at” (@) sign allows you to 
retrieve the last form-appropriate 
record you displayed in most, but not 
all, cases.

A list of all records appropriate 
for this form.

An ellipsis (...) Due to the size of Person and 
Organization LookUp, the ellipsis is 
not supported for these files.

A list of fields in the file that 
contains the record you are 
seeking.

A semicolon (;) You can use the field names to 
construct a query statement to look 
for a record.

Table 1-2:  Standard LookUp Shortcuts  
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Finding a Record
All records in which a specific 
field contains a value (that is, 
the field is not blank).

;fieldname

For example, on the Approvals 
Needed (APRN) form in the 
Financial System’s Accounts 
Payable module, to see a list of 
approval records for individuals who 
are limited in the purchase order 
amount they may approve, enter the 
following:

;apprv.po.max.amt

All records in which a specific 
field’s value matches a 
particular string.

;fieldname string

For example, on the Approvals 
Needed (APRN) form in the 
Financial System’s Accounts 
Payable module, to see a list of 
approval records for individuals who 
can approve up to $10,000 on a 
purchase order, enter the following:

;apprv.po.max.amt  
10000

Text values, such as “Hall,” are often 
case-sensitive.

With the exception of a person’s 
name, multiword values must be 
enclosed within double quotes.

You can also look for multiple values 
at one time. For example, to see a 
list of approval records for 
individuals who can approve up to 
$10,000 or up to $15,000 on a 
purchase order, enter the following:

;apprv.po.max.amt  
10000 15000

All records in which a specific 
field’s value begins with a 
particular string.

;field string...

For example, on the Job Skill 
Definition (JSKL) form in the Human 
Resources System’s Personnel 
module, to see a list of all job skill 
definitions whose descriptions begin 
with the word “Typing” or “Type,” 
enter the following:

;jsk.desc Typ...

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you 
know how it starts.

Remember that text values, such as 
“Typ,” are often case-sensitive.

When you want to see...
Enter this at the LookUp 

prompt
Hints

Table 1-2:  Standard LookUp Shortcuts (cont’d)
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All records in which a specific 
field’s value contains a 
particular string.

;fieldname  
...string...

For example, on the Job Skill 
Definition (JSKL) form in the Human 
Resources System’s Personnel 
module, to see a list of all job skill 
definitions whose descriptions have 
the word “Typing” or “Type” in them, 
enter the following:

;jsk.desc ...Typ...

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you 
know that it contains a certain word 
or part of a word.

Remember that text values, such as 
“Typ,” are often case-sensitive.

All records in which a specific 
field’s value ends with a 
particular string.

;fieldname 
...string

For example, on the Job Skill 
Definition (JSKL) form in the Human 
Resources System’s Personnel 
module, to see a list of all job skill 
definitions whose descriptions end 
with the word “Wpm,” enter the 
following:

;jsk.desc ...Wpm

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you are 
fairly certain about how it ends.

Remember that text values such as 
“Wpm,” are often case-sensitive.

When you want to see...
Enter this at the LookUp 

prompt
Hints

Table 1-2:  Standard LookUp Shortcuts (cont’d)
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All records in which a specific 
file’s value contains several 
strings.

;fieldname 
...string1...string2

or any combination of strings and 
ellipses to achieve the desired 
result.

For example, on the Job Skill 
Definition (JSKL) form in the Human 
Resources System’s Personnel 
module, to see a list of all job skill 
definitions whose descriptions 
contained the word “Typing” followed 
by the number “80,” enter the 
following:

;jsk.desc  
...Typing...80...

Use this option when you are not 
sure how the item you are looking 
for is spelled or worded but you 
know that it contains certain words 
or parts of words. You can use any 
combination of ellipses and strings 
to find what you are looking for.

Remember that text values, such as 
“Typing,” are often case-sensitive.

All records in which a specific 
field’s value is related in some 
way to a particular string (for 
example, is greater than or 
less than something).

;fieldname operator  
string

The following are valid operators:

• = or EQ (equal)

• <> or NE (not equal)

• > or GT (greater than)

• >= or GE (greater than or 
equal to)

• < or LT (less than)

• <= or LE (less than or equal to)

• UNLIKE (use this operator only 
when you use an ellipsis in 
specifying a data value)

For example, on the Approvals 
Needed (APRN) form in the 
Financial System’s Accounts 
Payable module, to see a list of 
approval records that were added on 
or after January 1, 1999, enter the 
following:

;approvals.add.date  
ge 010199

When you want to see...
Enter this at the LookUp 

prompt
Hints

Table 1-2:  Standard LookUp Shortcuts (cont’d)
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Person- and Organization-Related LookUp Shortcuts

The information most commonly used to look for a person or organization is 
the name of the person or organization. Table 1-3 presents the LookUp 
shortcuts you can use with person- and organization-related LookUps.
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When you want to...
Enter this at the LookUp 

prompt
Hints

Search using a person’s name. lastname (at least the first two 
letters)

lastname, firstname

lastname, firstname 
middlename

lastname, firstname 
middleinitial

firstname lastname

firstname middlename 
lastname

firstname middleinitial 
lastname

For example, to look for or add a 
new person with the name of 
Robert Taylor Smith, you could 
enter any of the following:

sm

smi

smith

smith, robert

smith, robert taylor

smith, robert t

robert smith

robert taylor smith

robert t smith

You must enter an underscore (_) 
between the parts of multiword 
names. For example,

van_dyke, jo_anne

You can also enter only the 
beginning of the first and last 
names (at least the first two letters 
of the last name). For example,

sm, ro

ro sm

LookUp finds any record with a 
primary, birth, former, or other 
name like the name entered.

If you choose to add a new record 
after looking someone up by his or 
her name in this manner, then 
regardless of how you entered the 
name, each word in the name is 
transformed into lowercase and 
then capitalized appropriately; for 
example, if you enter van_dyke, 
jo_anne, you would get “Jo Anne 
Van Dyke.”

Table 1-3:  Person- and Organization-Related LookUp Shortcuts  
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Limit a name search. Enter any of the following after the 
name:

;c city

;st state/province

;z zipcode/postalcode

;f country

;y class

;s source

;ps status

For example, to find the Robert 
Smith whose preferred address is 
in Boston, enter the following:

robert smith ;c boston

You can string together more than 
one restriction for a search, as 
long as you separate each 
element of the search with a 
semicolon.

For example, to find the Robert 
Smith whose preferred address is 
in Boston and who is associated 
with the reunion class of 1954, 
enter the following:

robert smith ;c boston  
;y 1954

Search using a particular Social 
Security or Social Insurance 
number.

;ss SSN/SIN

For example, Mary Browning’s 
Social Security number is 264-99-
8765. If she gives you her Social 
Security number instead of her ID 
number, enter the following to look 
her up:

;ss 264998765

You may enter hyphens, but they 
are not necessary.

When you want to...
Enter this at the LookUp 

prompt
Hints

Table 1-3:  Person- and Organization-Related LookUp Shortcuts (cont’d)
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Search using an organization’s 
name.

orgname

For example, to look for or add a 
new organization with the name of 
Universal Office Supplies, you 
could enter any of the following:

universal

office

supplies

universal office

universal office supplies

If you choose to add a new record 
after looking up an organization by 
its name, then regardless of how 
you entered the name, each word 
in the name is transformed into 
lowercase and then capitalized 
appropriately; for example, if you 
enter universal office 
supplies, you get “Universal 
Office Supplies.”

Limit a name search. Enter any of the following after the 
name:

;c city

;st state/province

;z zipcode/postalcode

;f country

For example, if you wanted to find 
the Universal Office Supplies in 
Dayton, you could enter the 
following:

universal ;c dayton

When you want to...
Enter this at the LookUp 

prompt
Hints

Table 1-3:  Person- and Organization-Related LookUp Shortcuts (cont’d)
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Adding Records from a LookUp

You can also use LookUps to add new records from certain forms.

LookUp Strings

You can string together several LookUp criteria. For example, on the 
Campaign Planning (CMP) form in the Alumni and Development System’s 
Campaign Management module, if you wanted to find the campaigns that 
start in March and that have a campaign goal of $10,000 or more, you would 
enter the following:

;activity.donation.goal    ge    10000    ;activity.start.mo
nth    3

When you want to...
Enter his at the LookUp 

prompt
Hints

Preserve capitalization as entered 
when adding a new person.

=name

For example, if you enter 
=JoAnne T di_Marco, then 
the name displays exactly as you 
entered it. If you enter only 
joanne t di_marco, then 
the name is capitalized as follows: 
Joanne T. Di Marco.

If the name is not preceded by an 
equal sign, then regardless of how 
you entered the name, each word 
in the name is transformed into 
lowercase and then capitalized 
appropriately.

Preserve capitalization as entered 
when adding a new organization.

=orgname

For example, if you enter =e e 
cummings Institute, then 
the name will be displayed exactly 
as you entered it. If you enter only 
e e cummings Institute, then the 
name is capitalized as follows:

E E Cummings Institute

Table 1-4:  Adding Records from a LookUp Prompt
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Viewing Online Help

Online help provides you with detailed information about Envision forms. 
There are three categories of online help:

■ Field Help. An explanation of each field on each form.

■ Function Help. A list of frequently used keyboard shortcuts.

■ Process Help. An overview of each form.

Field Help

To access field help while working in a form, go to the field for which you 
would like help, and do one of the following:

■ Choose Field Help from the Help menu.

■ Click the Field Help button  on the toolbar.

Function Help

Keyboard Shortcuts are keystroke combinations that can be used to perform 
functions that are normally accessed by using the mouse in Windows.

To access a list of frequently used keyboard shortcuts from any location 
within a form, choose Function Help from the Help menu. The HELP and 
FUNCTION KEY Information box is displayed, as shown in Figure 1-32. 

Note:  The About command in the Help menu enables you to view 
version and licensing information.
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Figure 1-32: Help and Function Key Information Box

Process Help

Process help provides you with an overall description of the purpose of the 
selected form. It does not provide detailed information about specific fields on 
a form. To access process help from any location within a form, choose 
Process Help from the Help menu.
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In This Chapter

This chapter helps you learn how to use UI with Benefactor or Colleague. It 
includes an overview for accomplishing various tasks, such as using Query 
Builder, Importing and Exporting records, Batch Processing, and using the 
Multiline text editor.

These utilities are wIntegrate products. For detailed instructions for using 
these utilities, please refer to wIntegrate documentation or online help.

Query Builder

Query Builder is a UniData utility that Datatel makes available with 
Colleague and Benefactor. It provides a front end to the query language on 
your host system.

To access Query Builder, choose Query Builder from the Options menu. The 
Query Builder dialog box is displayed, as shown in Figure 1-33.

Note:  Query Builder, Import File, and Export File are available only to 
clients using UniData. Clients using SQL Server or Oracle can use the 
utilities provided with those products.

Note:  Because access to Query Builder is governed by Envision 
security classes, you may need to consult your system administrator 
to obtain the necessary permissions.
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Figure 1-33: Query Builder Dialog Box
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Importing and Exporting Files

Import File and Export File are UniData utilities that Datatel makes available 
with Colleague and Benefactor. Import File and Export File allow you to 
transfer data to and from your host PC.

To import or export files from the host PC, choose Import File or Export 
File from the Options menu. The Import File From Host dialog box is shown 
in Figure 1-34, and the Export File to Host dialog box is shown in 
Figure 1-35.

Figure 1-34: Import File From Host Dialog Box

Note:  Because access to Import File and Export File is governed by 
Envision security classes, you may need to consult your system 
administrator to obtain the necessary permissions.
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Figure 1-35: Export File to Host Dialog Box
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Batch and Report Processes

When you run batch and report processes, the Progress Bar Graph displays the 
progress of each process.

As each process completes, Envision displays a Finish prompt. Click Finish 
to start the next process and view its progress. Continue clicking Finish as 
each prompt appears.

To view all of the processes consecutively (without having to click Finish for 
each process), select the Close automatically when complete check box.

There are four types of progress bar graphs.

Message Bar Graph

This type of graph displays the messages of a process, without the progress 
bar.

Figure 1-36: Message Bar Graph
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Single-Process Bar Graph

This type of graph displays a single process in a bar graph.

Figure 1-37: Single-Process Bar Graph

Multiple-Process Bar Graph

This type of graph displays more than one process in multiple bar graphs.

Figure 1-38: Multiple-Process Bar Graph
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Terminal Window Bar Graph

This type of graph displays the Process Generator (GEN) and Screen Painter 
(Painter) processes. Your system administrator can optionally choose to 
display all of your bar graphs in a Terminal Window. The administrator can 
also choose to display specific processes in the terminal window bar graph.

Figure 1-39: Terminal Window Bar Graph
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Browsing Reports

The Report Browser allows you to view reports easily in a Windows 
environment. During viewing, the browser imports the document one page at 
a time as requested, to avoid lengthy download times.

Procedure for Browsing a Report

To use the Report Browser, perform the following steps:

Step 1. Select the desired report from the treemenu.

Step 2. Enter the desired report parameters, and update from the form.

Figure 1-40 shows an example of the report parameters.

Figure 1-40: Bank Deposit Report (BDEP) Form

Note:  Because the Report Browser delivers the report to the client 
one page at a time, there is a momentary delay between clicking a 
page selection button and seeing the page appear on the form.
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Step 3. On the Peripheral Defaults form, select H    Hold/Browse    File    Output in 
the Output Device field, as shown in Figure 1-41.

Figure 1-41: Output Device Field: Peripheral Defaults Form

Step 4. Continue to complete the forms until a bar graph displays. (See “Batch and 
Report Processes” on page 1-49.)

Note:  Depending on the type of report, Envision displays various 
forms that you continue to update. For example, many processes 
generate an error report in addition to the output report. Envision 
opens a Peripheral Defaults form for each report. Also, Envision often 
opens the Process Handler form that allows you to set processing 
parameters.
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Step 5. When all records are processed, you are prompted to browse the HOLD files. 
The Report Browser is displayed. Figure 1-42 shows a typical report page in 
the Report Browser.

Figure 1-42: Report Browser

Title Bar Tool Bar

Scroll Bars
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Using the Report Browser Toolbar

Use the toolbar buttons, shown in Figure 1-43, to navigate through the report, 
print the report, or save a copy.

Figure 1-43: Report Browser Toolbar Detail

The Report Browser Toolbar buttons are described in Table 1-5.

Import

Exit 
Browser

First Page

Current Page/ 
Total Pages/
Change Page

Previous Page

Next Page Last Page

Print Remote

Print Local

Button Name Description

Exit Browser Close the Report Browser and return to the application workspace.

Import Save a copy of the report to your network or local hard drive. You are 
prompted to specify a name and path for the saved report.

First Page Jump to the first page of the report.

Previous Page Move to the previous page of the report.

Current Page/Total 
Pages/Change Page

Shows the number of the currently displayed page and the total 
number of pages in the report. You can also jump directly to any page 
by typing the page number in this field and then pressing Enter.

Next Page Move to the next page of the report.

Last Page Jump to the last page of the report.

Table 1-5: Report Browser Toolbar Buttons  
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Setting Report Browser Preferences

You can resize the browser window to fit any selected report. If the entire 
report does not fit on the form, vertical and horizontal scroll bars enable you 
to view any part of it, as shown in Figure 1-42 on page 1-54. To customize the 
font, background color, and text color, choose Font or Change Colors from the 
Options menu. See “The Multi-Line Text Editor” beginning on page 1-58 for 
information on setting report browser colors and fonts.

Print Local Print the report to a local printer (such as a printer that is accessible 
from Windows). This option downloads the report to your PC and 
uses Windows to print the report. When you select Print Local, a 
Printer Setup dialog box is displayed.

For best results with the Print Local option, you must choose an 
appropriate font size and page orientation. If the font is too large, the 
report may not page properly or may be truncated short of the right 
margin.

For reports that are up to 80 characters wide, click the Use Font 
check box on the printer setup dialog and choose Courier New, 10. 
Click the radio button for Portrait orientation.

For reports that are from 81 to 132 characters wide, click the Use Font 
check box on the printer setup dialog and choose Courier New, 8. 
Click the radio button for Landscape orientation.

In all cases, make sure that the Use character mapping check box is 
checked.

Print Remote Print the report to a printer that is accessible from the host. This 
option uses the operating system on the host to print the report, 
without downloading it to your PC.

Button Name Description

Table 1-5: Report Browser Toolbar Buttons (cont’d)
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Adding a Database

When you initially install UI on your PC, you have access to only one 
database. Before you can access additional databases, you or your 
administrator must add them. Adding a database connects you to the 
Colleague and Benefactor accounts that you need to access.

Use this procedure if you are adding a database from the Options menu in UI. 
System Administrators can also add a database from the Datatel User Setup 
program. For instructions for doing so, refer to User Interface Installation and 
Administration.

Procedure for Adding a Database

Step 1. From the Options menu in UI, select Add/Remove Databases.1

The Add/Remove Databases window displays.

Step 2. Select the available databases (listed in the Available Databases window) that 
you want to be able to access through UI Desktop. Move each of those 
databases to the Installed Databases window by selecting the database and 
then clicking the single left arrow button.

Step 3. Click OK to add the databases.

1. If the “Add/Remove Databases” option does not appear on the Options menu, it may have been disabled for 
you. Contact your system administrator.

Click to 
add a 

database
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The Multi-Line Text Editor

UI gives you the option to use either a single-line text editor or the multi-line 
text editor on the many Envision forms that let you edit text. This multi-line 
text editor automatically “wraps” the text when you come to the end of a line. 
This function lets you enter text without having to use a “hard carriage return” 
when you get to the end of line, similar to most desktop publishing software.

The multi-line text editor lets you select multiple lines of text or all lines of 
text and perform a “copy and paste.” See “Copy and Paste Text” on 
page 1-63. 

Single-Line Text Editor vs. Multi-Line Text Editor

The fundamental difference between a single-line text editor and a multi-line 
text editor is the automatic “text wrapping” capability. With a single-line text 
editor, you must manually start another line when entering text. This can be 
cumbersome when you have a large amount of text to enter. An example of a 
single-line text editor form is shown in Figure 1-44 on page 1-59.

The multi-line text editor form lets you enter free-form text without entering 
hard returns. The text wraps automatically as you type. An example of the 
multi-line text editor is shown in Figure 1-45 on page 1-59. 

Note:  There are some limitations that you and your system 
administrator need to consider before implementing the multi-line text 
editor. For a discussion on these limitations, see User Interface 
Desktop or Web Installation and Administration. 
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Figure 1-44: Example of a Single-Line Text Editor Form 

Figure 1-45: Example of the Multi-Line Text Editor Form
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When using the multi-line text editor, loading a large amount of text may take 
more time than a single-line editor. With a single-line text editor, the form 
“loads” the text one form, or fifteen lines, at a time. With the multi-line text 
editor, the entire block of text is loaded at once. 

Using the Multi-Line Text Editor 

When you want to use the multi-line text editor to enter a block of text, detail 
on a field that has UTEDIT capability, such as a Comments field or 
Description field2. If there is existing text in the field from which you are 
detailing, and that text exceeds the text limits of the multi-line text editor, you 
will receive an alert message indicating the condition as shown in 
Figure 1-46. 

Figure 1-46: Text Exceeding Maximum Line Length Alert Message 

If you select Y on the Alert dialog box, the text will wrap on the multi-line text 
editor form. You can then edit the text as needed. (If you decide not to keep 
the modified text and want the original text, select Cancel.)

If you select N on the Alert dialog box, the text will wrap on the multi-line text 
editor form, but you cannot edit the text. (The editor form displays in inquiry-
only mode when you select N on the Alert dialog box.)

Figure 1-47 shows an example of text that exceeds the maximum line length. 
In this particular field, you can scroll through the field to read the text. When 
you detail from the field, you’ll receive the Alert dialog box.

2. Not all fields with UTEDIT capability will have the multi-line text editor feature. 
Some forms and fields are not coded to use the editor feature, but most are coded to 
take advantage of the multi-line text editor.
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Figure 1-47: Example of Text Exceeding Maximum Line Length 

If you use the multi-line text editor and want to keep text as it is, select N from 
the Alert dialog box. Although the text will display wrapped on the text editor 
(in inquiry-only mode) as shown in Figure 1-48, the actual format will not be 
altered.

Figure 1-48: Multi-Line Text Editor in Inquiry-Only Mode

Row 1

Row 2

Row 3
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Although the text displays in inquiry mode in the multi-line text editor, you 
can still use a line editor (if you have access) to modify the text. (The text is 
inquiry-only on the multi-line text editor.) To use a line editor, detail from the 
multi-line text editor to access your line editor of choice. An example is 
shown in Figure 1-49. 

Figure 1-49: Detailing from the Multi-Line Text Editor in Inquiry-Only Mode

Detail to access a 
line editor
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However, if you select Y on the Alert dialog box, the text reformats in the text 
editor. You can make changes, but if you save the information (without 
cancelling), the text retains the new format. An example of the multi-line text 
editor in edit mode is shown in Figure 1-45.

Copy and Paste Text

The multi-line text editor lets you copy text from a source document and paste 
the text into the multi-line text editor. For example, you may have text from 
an e-mail or other document that you want to copy into a Comments field or a 
Description field. You can use standard copy and paste procedures between a 
source document and the multi-line text editor. 

Note:  When the text is wrapped, each line of the text is placed in its 
own line within the record. In the example above, the one, long line of 
text is wrapped, so the one sentence is split into four separate lines 
within the record after reformatting. 

Note:  The multi-line text editor does not support graphics, so you 
cannot cut and paste any graphic images into the editor. However, you 
can copy text from the multi-line text editor when in inquiry-only mode.
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Loading Existing Records

If you want to load an existing record into the multi-line text editor, you can 
detail from the multi-line text editor (in edit mode or in inquiry-only mode) to 
a line editor, then perform that editor’s standard load command. An example 
is shown in Figure 1-50. 

Figure 1-50: Detailing from the Multi-Line Text Editor to a Line Editor 

Detail to access
a line editor
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If the text you load exceeds the length of the maximum line length, the Alert 
message displays (as shown in Figure 1-46 on page 1-60). Select Y to 
reformat the loaded text, or select N to ignore any changes.

Date and Time Stamp

With the single-line text editor, you can use the pound key symbol (#) to date 
and time stamp your text. You can use the Date/Time/Login option from the 
Edit menu as shown in Figure 1-51.

 

Figure 1-51: Example of the Date/Time/Login Option  

Note:  You can use the Date/Time/Login option on many fields, not just 
Comment fields and Description fields.
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In This Chapter

This chapter helps you learn how to customize the look and feel of UI with 
Benefactor or Colleague. It includes instructions for defining user preferences 
and field customization.

Defining Your Preferences

UI provides you with a way to personalize the look and feel of how the forms 
appear on your PC. You can define your preferences for the following:

■ Font

■ Colors

■ Favorites

UI supports multiple user settings on one PC. If a PC is shared by more than 
one user, UI maintains individual color settings, font sizes, and favorites 
menus for each user ID.
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Defining Fonts

You can use the Fonts dialog box to change the text fonts that are used in 
forms, reports, resolution forms, and the multi-line text editor.

Procedure for Defining Font Preference

Follow these steps to define your font preferences:

Step 1. From the Options menu, choose Font. The Font dialog box is displayed, as 
shown in Figure 1-52.

Figure 1-52: Font Dialog Box

Note:  For best results, we recommend that you configure your 
Windows display to use small fonts. With lower resolutions, such as 
800x600, some forms and resolution forms may not display correctly 
using large fonts.
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Step 2. Use the drop-down lists to set the font styles and sizes individually for forms, 
reports, and resolution forms. Click OK to save the settings. The new settings 
will take effect the next time you start UI. 

Defining Colors

You can use the Color options to change the colors of a variety of form 
attributes. Follow these steps to define your color preferences:

Step 1. From the Options menu, choose Change Colors. The Visual Attributes dialog 
box displays, as shown in Figure 1-53.

Figure 1-53: Visual Attributes Dialog Box

Note:  If you want to use a font that is available on your PC but not 
included in a drop-down list, type the font name into the edit field. If the 
font is available, the sample text below the edit field adjusts to the new 
setting. If the sample text does not change, the font is not valid. 
 
UI supports proportional fonts; however, resolution forms and the 
Report Browser require the use of fixed fonts because of the precise 
formatting of their output. For these fonts, you are restricted to the 
values supplied in the drop-down list.

Note:  The font you set for the resolution form is the same font that will 
be used by the multi-line text editor. For information about the multi-
line text editor, see “The Multi-Line Text Editor” on page 1-58. 
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Step 2. The Visual Attributes dialog box allows you to change any foreground or 
background color setting. Click Font    Color or Background to the right 
of the Example Text for the color you want to change. A color palette 
displays, as shown in Figure 1-54.

Figure 1-54: Color Palette

Step 3. Select the color you want, and click OK to save the setting and return to the 
Visual Attributes dialog box.

Step 4. When all color selections are complete, click OK in the Visual Attributes 
dialog box to save the settings.
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Defining Favorites

You can use the Favorites drop-down menu to store and organize a list of 
shortcuts to forms and functions that you frequently use.

Procedure for Adding Favorites

Perform the following steps to add a form shortcut to your Favorites list:

Step 1. Select the form that you want to add to your list of favorites. 

Step 2. Select Add to Favorites from the Favorites menu.

Step 3. Click the Add to Favorites pop-up. The Add Favorite dialog box displays, as 
shown in Figure 1-55.

Figure 1-55: Enter a Mnemonic Dialog Box

Step 4. Enter the mnemonic of the favorite form.

Step 5. If you use folders to organize your Favorites, you can click Create    in to 
select an existing folder or create a new folder for the shortcut, as shown in 
Figure 1-56.
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Figure 1-56: Selecting a Folder for a Favorite

Step 6. Click OK to add the form to your customized Favorites list. 

The shortcut is added to your Favorites drop-down menu, as shown in 
Figure 1-57.

Figure 1-57: Favorites Drop-Down Menu

Note:  See “Organizing Favorites” beginning on page 1-73 for more 
information on organizing Favorites in folders.
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Organizing Favorites

Choose Organize Favorites from the Favorites menu to manage your list of 
shortcuts. You can create new folders, rename folders, delete unwanted 
folders, remove forms from Favorites, and move items from one folder to 
another.

Note:  To display the Enter a Mnemonic dialog box and add a shortcut 
to Favorites without first selecting the form from the treemenu, choose 
Add to Favorites from the Favorites menu and enter the mnemonic of 
the desired form. 
 
If you have a form open and want to add it to your Favorites list, 
choose Add Current Screen to Favorites from the Edit menu. The 
Enter a Mnemonic dialog box is displayed with the current form 
mnemonic filled in, as shown in Figure 1-55 on page 1-71.

Note:  A form cannot be renamed. However, you can create a folder 
with a descriptive name that will help you remember the form’s 
function, and then store the form shortcut in the folder. Folders can be 
used to classify forms by function, workflow, or any other property.
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Procedure for Creating a New Folder

Perform the following steps to create a new folder:

Step 1. Choose Organize Favorites from the Favorites menu. The Organize 
Favorites window is displayed, as shown in Figure 1-58.

Figure 1-58: Organize Favorites Window

Step 2. Click Create    Folder to display the Create Folder dialog box, as shown in 
Figure 1-59.

Figure 1-59: Create Folder Dialog Box
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Step 3. Enter a name for the new folder, such as “Reports,” and click OK. The new 
folder appears in the Organize Favorites window, as shown in Figure 1-60.

Figure 1-60: New Folder
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Procedure for Moving a Shortcut to a Folder

Perform the following steps to move a shortcut to a folder:

Step 1. In the Organize Favorites window, select the shortcut you want to move by 
clicking on it.

Step 2. Click Move    to    Folder. The Folder Selection window is displayed.

Step 3. Click on the desired folder to select it, as shown in Figure 1-61.

Figure 1-61: Folder Selection Window

Step 4. Click OK. The shortcut is moved to the folder.

Note:  In addition to moving shortcuts, you can move folders into other 
folders to create a hierarchical structure.
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Procedure for Renaming a Folder

Perform the following steps to rename a folder:

Step 1. In the Organize Favorites window, select the folder you want to rename by 
clicking on it. Click Rename. The folder name is now editable.

Step 2. Enter the new folder name and click Close to close the Organize Favorites 
window and save the change.
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Procedure for Deleting a Shortcut or a Folder

Perform the following steps to delete a shortcut or a folder:

Step 1. In the Organize Favorites window, select the shortcut or folder you want to 
delete from Favorites by clicking on it.

Step 2. Click Delete. The shortcut or folder is removed from the Organize 
Favorites window and from the Favorites drop-down menu.

Note:  You cannot delete a folder unless it is empty. To delete a folder, 
first move or delete all of its contents.

Note:  When you delete the shortcut to a form from Favorites, the form 
is still accessible through the menus, the address bar, and the Run 
dialog box. You have deleted only the shortcut in the Favorites drop-
down menu.
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Field Customization

The behavior for each field on each form is originally defined by Datatel. The 
System administrator at your institution can use the Envision Tool Kit to 
further define field behavior. A third level of field customization allows you, 
the end-user, to modify certain field behaviors for the forms that you access.

You can specify field behavior for a form from within the form itself. 
Selecting Customize Field Properties from the Tools menu of the form you 
want to customize allows you to specify field sequence and field access for 
that form.

■ Field Sequence. Specify which field the cursor appears in when a user first 
accesses the form, and the path followed through the form each time a user 
presses the TAB key.

■ Field Access. Indicate which fields on the form are required. You can also 
indicate whether a field is Inquiry Only or No Access.

Limitations 

You cannot take away behavior that either Datatel or your system 
administrator has already defined in the Tool Kit. For example, if a field is set 
in the Tool Kit as Required, it is always required. 

See Figure 1-62 for an example of the Customize Field Properties dialog. The 
example shows customization of the NAE form, but any Envision form can be 
customized.

Note:  Before you can customize fields for a form, your system 
administrator must first enable field customization for you and set up 
your field customization preferences.
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Figure 1-62: Customize Field Properties Dialog

Process
field number

Tab
sequence

Customization
already applied

Technical Tip: When you access the Customize Field Properties 
dialog from a form, you can view existing customizations for that form. 
A series of tool tips indicates the process number of each field, as well 
as the tab sequence of each field. Tool tips are the numbered boxes 
that display when this option is enabled.

A tool tip field that is red indicates that customization is already 
applied to that field.
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Customizing Field Sequence

You can use field customization to determine the tab sequence of fields on a 
form. Customizing your field sequence can help you move through a form 
more quickly than you would if you had to tab through each field on the form. 
You can specify the field you want to start in first and the order in which to 
visit each subsequent field. Each time you press the TAB key, you move to the 
next field in the specified tab sequence (skipping any fields not in the tab 
sequence). If you specify a last field, the form updates when you tab from the 
last field in your customized tab sequence.

If tab sequencing is not specified, the default sequence is used.

Customizing Field Access

You can use the Field Access feature to select a security control for fields on a 
form. If field access is not specified, the default User Interface form behavior 
occurs.

You can select one of the following options:

■ Required. A field on a form is required. Users cannot finish from the form 
without entering data into the required fields.

■ Inquiry Only. Users may only view the data; they cannot update or delete 
data.

■ No Access. Users cannot view, add, change, or delete data. If a field is 
already specified as Denied Access through security classes as defined on 
the Field Security Definition (SCDF) form, it is always Denied Access 
(Denied Access performs the same functionality as No Access).

Field Customization Restrictions

The behavior for each field on each form is originally defined by Datatel. 
System administrators can use the Envision Tool Kit to further define field 
behavior for an institution. You cannot take away behavior that is defined in 
the Tool Kit. The following rules apply to Customize Field Properties fields:

Precedence

■ Tab sequence precedence is exclusive. If one user creates a tab sequence 
and applies it to all users, subsequent users may still create a tab sequence 
for themselves, and that tab sequence will apply only to their own sessions.
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UI Desktop and UI Web: Customization
■ Field access precedence is inclusive. If one user restricts field access from a 
field for all users, and a second user restricts field access from a second 
field for himself, the second user will not be able to access either field. If 
the same field has access restrictions for both all users and a specific user, 
the most restrictive access is always used.

First Field

■ A form can have only one First Field. Once a First Field is designated, you 
cannot make any other field the First Field unless you remove the existing 
designation.

Last Field

■ Fields that contain a Next Field Override cannot be designated as the form’s 
last field. 

Next Field Override

■ Fields that are specified as Last fields cannot have a Next Field Override.

■ Other fields that cannot have a Next Field Override include: fields 
contained in the header block and window fields that are not window 
controllers (unless the current Process Field is a member of the same 
window).

Field Access

■ Fields appearing in the form’s header block can only have No Access 
restrictions applied to them.

■ When you apply a field access restriction (required, inquiry only, no access) 
to a field, you cannot apply any other field access restrictions.

■ If a field is specified as required by Envision, you cannot modify any of the 
access options.

■ If a field is specified as no access by Envision security, you cannot modify 
any of the access options.

■ If a field is specified as inquiry-only by Envision, you only have the option 
to make the field no access.
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Defining Your Preferences
Procedure for Customizing Fields on a Form

You might not have access to all of the options provided in this procedure. 
The options that you are presented with correspond with the level of access 
granted to you by your system administrator. This procedure describes the 
process as if you have access to all of the customization options.

Step 1. Access the form you wish to customize.

Step 2. From the Tools menu, select Customize Field Properties to display the 
Customize Field Properties dialog.

Figure 1-63: Customize Field Properties Dialog

Step 3. Indicate if you want to modify the field properties for all users or a specific 
user:

■ Selecting Modify All Users applies the customization to all users in 
the database.

■ Selecting Modify Specific Users provides you with a dialog to 
enter the login ID of a specific user you would like to apply the 
customization to.

■ Do nothing if you want to modify the field properties only for yourself.

Step 4. In the Process Field drop-down list, select the number of the field you want to 
modify.
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Step 5. Indicate the field sequence you want to apply to the field.

■ Select First Field if you want to indicate that the selected field is the 
first field in the tab sequence. 

■ Select Last Field if you want to indicate that the selected field is the 
last field in the tab sequence.

■ Select the next field in the tab sequence from the Next Field Override list.

Step 6. Indicate the level of field access you want to apply to the selected field.

■ Selecting Required prevents users from finishing from the form without 
populating it.

■ Selecting Inquiry Only allows users to only view the data; they cannot 
update or delete data.

■ Selecting No Access prevents users from viewing, adding, changing or 
deleting data.

Step 7. Repeat steps 3-6 for each field you wish to customize.

Step 8. Click OK.

Note:  You do not need to click OK after customizing each field. You 
can click OK after making customizations to all of the fields on a form 
to apply all of the customizations.

Clicking Clear Field removes customizations for the currently 
selected Process Field. All other customizations are left unchanged.

Clicking Clear All removes all customizations for the current form, 
for the user you are editing.
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Defining Your Preferences
Procedure for Disabling Field Sequence

After you set up custom field sequencing, you can indicate whether you want 
to activate the customizations by using the Enable/Disable Field 
Customization feature.

Step 1. Access the form you customized.

Step 2. From the Tools menu, do one of the following:

■ Select Disable Custom Field Sequence to disable the custom field 
sequencing. A check displays next to this option when field sequencing is 
disabled.

■ De-select Disable Custom Field Sequence to enable the custom field 
sequencing.

Procedure for Showing Field Sequence

You can optionally display the current field sequence of a form. If you 
customized a field sequence, your customization displays. If you did not 
customize a field sequence, the default field sequence displays.

Step 1. Access the form you customized.

Step 2. From the Tools menu, do one of the following:

■ Select Show Field Sequence to view the field sequence.

■ De-select Show Field Sequence to view the form without displaying the 
field sequence.

Note:  When you disable custom field sequencing, it is disabled only 
for the current session. When you log out of the form and return, field 
sequencing will be enabled again.
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About the Character Interface May 24, 2006

In This Chapter

This chapter provides a brief introduction to some of the terms and concepts 
you will encounter in using Envision-based modules in Colleague and 
Benefactor. This chapter is divided into the following sections: 

■ Function Keys — where we provide a list and description of each of the 
function keys available with Envision-based modules.

■ Form Types — where we present an example of each of the four types of 
Envision forms.

■ LookUp — where we describe the LookUp feature and provide an example 
of its use.

■ Groups — where we provide an illustration of the components of a group.

Technical Tip: The Character interface is not available for Colleague 
R18 and later.
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Function Keys

Table 2-1 provides a list of Benefactor and Colleague function keys.

Throughout the Colleague and Benefactor documentation you will find that 
we refer to these keys by their functions rather than by specific key names. 
This is because their key assignments may vary from keyboard to keyboard. 
We have provided a blank column in this table where you may make a note of 
the keys on your keyboard that correspond to these functions.

Note:  Once you determine which key corresponds to Function Key 
Help (Funct HELP), then you can press Funct HELP to find out what 
the rest of the key assignments are.

Keyboard Function Function Description

General

CANCEL Cancels changes made to current 
record.

DETAIL Displays detail form (cursor must be 
positioned on a field marked with an 
asterisk).

DIRECT ACCESS Invokes another process from current 
process form without returning to 
menu. If current process form has a 
LookUp prompt, respond to prompt 
before pressing this key.

Next, press Enter to continue, then 
enter mnemonic of next process.

EXIT Exits from current form and returns to 
menu from which it was accessed. If 
you used DIRECT ACCESS to display 
this form, you are returned to the menu 
from which the first process form was 
accessed.

Table 2-1:  List of Function Keys Available with Envision-Based Modules  
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Function Keys
FINISH Exits from current form and returns to 
menu from which it was accessed. If 
you used DIRECT ACCESS to display 
this form, you are returned to the form 
you were on when you pressed 
DIRECT ACCESS.

Press Enter to save your work or 
CANCEL if you do not want to save 
your work.

Field HELP Displays a one-line message.

Press Enter to view a longer help 
message or Field HELP to view a list of 
field values.

Funct HELP Provides a list of function keys and the 
keys to which they correspond on your 
keyboard.

Process HELP Displays general overview of process.

Record DELETE Deletes current record (available only 
on certain forms).

REFRESH Redisplays current form, erasing 
extraneous data or system messages.

UPDATE Exits from current record, redisplays 
current form, and prompts for a new 
record ID.

Press Enter to save your work or 
CANCEL if you do not want to save 
your work.

Field Movement

Field BACK Moves cursor back to previous field.

Field FWD Moves cursor forward to next field.

Field JUMP Jumps to a specified field.

Keyboard Function Function Description

Table 2-1:  List of Function Keys Available with Envision-Based Modules  
(cont’d)
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Window Movement

Element BACK Moves cursor to previous window 
element.

Element FWD Moves cursor to next window element.

Window BACK Moves cursor to previous window 
group.

Window BOTTOM Moves cursor to last window group.

Window FWD Moves cursor to next window group.

Window INSERT Inserts window group just before 
current group.

Window JUMP Jumps to a specified window group.

Window Page 
DOWN

Moves cursor to next page.

Window Page 
JUMP

Jumps to a specified window page.

Window Page UP Moves cursor to previous page of 
window.

Window TOP Moves cursor to first window group.

Form Movementa

Form FWD Moves to next the form.

Form BACK Moves to the previous form.

Form JUMP Jumps to a specified form. 

Keyboard Function Function Description

Table 2-1:  List of Function Keys Available with Envision-Based Modules  
(cont’d)
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Editing

Right-arrow Moves cursor right.

Left-arrow Moves cursor left.

BACKSPACE Moves cursor left and erases 
characters as you go.

Char DELETE With in-line editing on, deletes current 
character.

Char INSERT With in-line editing on, inserts 
characters at the current cursor 
location.

DEL Clears current field.

End of Line 
CLEAR

With in-line editing on, clears field from 
cursor position to end of field.

Insert/Overwrite Switches in-line editing on (insert 
mode) and off (overwrite mode).

An asterisk is displayed in the lower 
right-hand corner of the form when in-
line editing is off.

TAB Moves cursor eight spaces to right.

a. Supports movement among chained forms. Chained forms are a group of Envision 
forms that support a particular workflow. Chained forms are not delivered by Datatel 
but can be customized at your site. 

Keyboard Function Function Description

Table 2-1:  List of Function Keys Available with Envision-Based Modules  
(cont’d)
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Form Types

Menu

A menu, as shown in Figure 2-1, is an organized list of Benefactor or 
Colleague functions.

Figure 2-1: Menu Form

Mnemonic
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Form Types
Process Form

A process form, as shown in Figure 2-2, is a form you use to perform a 
Benefactor or Colleague function.

Figure 2-2: Process Form

Some process forms contain detail fields. A detail field is preceded by an 
asterisk (*), which indicates that you can access another form — a detail form 
— from the detail field.

Some process forms also contain groups, as shown in Figure 2-3. A group is a 
field that may contain multiple values for a given data item. Note that groups 
may also contain detail fields.

Header 
Block

Data Area

LookUp/Short 
Help Area

Mnemonic
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Figure 2-3: Process Form Containing a Table

Detail Field

Table
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Form Types
Inquiry Form

Inquiry forms, as shown in Figure 2-4, are much like process forms except 
that you cannot enter or change data.

Figure 2-4: Inquiry Form
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On-Line Help Form

Help forms, as shown in Figure 2-5, provide process, field, and function key 
help messages.

Figure 2-5: Help Form

■ Press Process HELP for an overview of what the current form does.

■ Press Field HELP for an explanation of the current field. Press Field HELP 
twice for a list of valid field values, where applicable.

■ Press Funct HELP to display a list and description of all function keys.

Process Help
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LookUp
LookUp

Before you can work with something, such as a donor record or a budget, you 
must identify the particular something, such as the exact donor record or exact 
budget, to Benefactor or Colleague. To assist you in finding the record you 
need, both Benefactor and Colleague provide the LookUp feature.

Basic LookUp

Enter the key, or ID, of the record you want at the LookUp prompt, as shown 
in Figure 2-6. The information associated with that record is then displayed 
for you. For example, Joe Smith’s ID number is 1035806. Enter 1035806 at 
the Person LookUp prompt on the Spouse Information (SPO) form to display 
Joe’s spouse information record.
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Figure 2-6: Example of Basic LookUp

More About LookUp

The real power behind LookUp comes into play when you do not know the 
record key.  LookUp provides options that help you find the record you need 
with the information you do have.

For example, the key to a donor record is the donor’s ID number. If you don’t 
know the ID for the donor record you need, you can enter the donor’s name 
(full or partial) instead.

1035806
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LookUp
See the online help for a LookUp field for specific information about the 
LookUp options available.
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Tables

Tables, as shown in Figure 2-7, are special fields that let you store more than 
one value for a given data item. They are, therefore, sometimes referred to as 
multivalued fields.

The following are the components of a table:

■ Row. Each numbered item in a table is a row.

■ Controller. The first data item in a table.

■ Element. Any data item in a table.

The status line, located at the bottom of the form, displays information to help 
you use table.

Figure 2-7: Example of a Table

Controller

Element

Row

Status Line
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